Abstract

RoadPlan is an interactive planning and preprocessing tool to analyse and optimize multi-agv traffic. Currently it provides facilities for:

- Traffic road map configuration and visualization
- Interactive drawing and modification of traffic layouts
- Collision and deadlock analysis of multiple agv’s on selectable routes
- Interactive agv-shape editing
- Automatic determination of collision and deadlock avoidance zones
- Generation of semaphore signaling along routes
- Simulation of agv traffic controlled by semaphores
Contents

Chapter 1  Introduction ........................................................................................................................................4

  1.1. Functionality ........................................................................................................................................4

  1.2. Using RoadPlan - overview ..................................................................................................................4

Chapter 2  Using the RoadPlan Program .............................................................................................................6

  2.1. Installing and running RoadPlan ...............................................................................................................6

  2.2. Software overview ......................................................................................................................................6

  2.3. RP-Script layer ..........................................................................................................................................7

  2.4. RP-Shell interfacing ...................................................................................................................................8

Chapter 3  Creating a road map file ....................................................................................................................9

  3.1. Poses .......................................................................................................................................................9

  3.2. Tracks .....................................................................................................................................................9

  3.3. Routes ....................................................................................................................................................10

  3.4. Nets .......................................................................................................................................................10

  3.5. Agv-types ..............................................................................................................................................10

  3.6. Environment variables ...........................................................................................................................10

  3.7. Example road map file ...........................................................................................................................11

Chapter 4  Loading a road map file ..................................................................................................................14

  4.1. The loading process ................................................................................................................................14

  4.2. Tracks in the layout ................................................................................................................................14

  4.3. Smoothing of routes ................................................................................................................................15

Chapter 5  Viewing the road map layout ..........................................................................................................16

  5.1. Adjusting the viewing region ....................................................................................................................16

  5.2. Coordinate positions ................................................................................................................................16

  5.3. Track and route identification ..................................................................................................................16

  5.4. Viewing road map text items ...................................................................................................................17

  5.5. Viewing routes .......................................................................................................................................17

  5.6. Viewing of agv-types scaled in the road map .........................................................................................18

Chapter 6  Defining Routes .............................................................................................................................19

  6.1. Selecting existing routes ........................................................................................................................19

  6.2. Defining new routes ................................................................................................................................19

Chapter 7  Creating or modifying a road map interactively ...............................................................................21

  7.1. Enabling editing of the track layout .........................................................................................................21

  7.2. Starting from scratch ..............................................................................................................................21

  7.3. Extension of a route beyond the existing track layout ...........................................................................21
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.4</td>
<td>Creation of tracks during route continuation</td>
<td>23</td>
</tr>
<tr>
<td>7.5</td>
<td>Deletion of tracks and/or routes</td>
<td>23</td>
</tr>
<tr>
<td>7.6</td>
<td>Saving the layout to a road map file</td>
<td>23</td>
</tr>
<tr>
<td>8.1</td>
<td>A net as fleet of agv’s</td>
<td>25</td>
</tr>
<tr>
<td>8.2</td>
<td>Selection of agv’s on routes</td>
<td>25</td>
</tr>
<tr>
<td>8.3</td>
<td>Selection of an existing net</td>
<td>25</td>
</tr>
<tr>
<td>8.4</td>
<td>Operations on the current or any existing net</td>
<td>25</td>
</tr>
<tr>
<td>8.1</td>
<td>Net composition</td>
<td>25</td>
</tr>
<tr>
<td>8.2</td>
<td>Selection of agv’s on routes</td>
<td>25</td>
</tr>
<tr>
<td>8.3</td>
<td>Selection of an existing net</td>
<td>25</td>
</tr>
<tr>
<td>8.4</td>
<td>Operations on the current or any existing net</td>
<td>25</td>
</tr>
<tr>
<td>9.1</td>
<td>Mutual analysis selection</td>
<td>26</td>
</tr>
<tr>
<td>9.2</td>
<td>Mutual configuration diagram</td>
<td>26</td>
</tr>
<tr>
<td>9.3</td>
<td>Collision and exclusion zones</td>
<td>26</td>
</tr>
<tr>
<td>9.4</td>
<td>Pinpointing configuration states</td>
<td>28</td>
</tr>
<tr>
<td>9.5</td>
<td>Exclusion zones and semaphores</td>
<td>29</td>
</tr>
<tr>
<td>9.6</td>
<td>Viewing critical sections and semaphore signs</td>
<td>30</td>
</tr>
<tr>
<td>9.7</td>
<td>Subdivision of exclusion zones</td>
<td>31</td>
</tr>
<tr>
<td>9.1</td>
<td>Mutual analysis of agv’s</td>
<td>26</td>
</tr>
<tr>
<td>9.2</td>
<td>Mutual configuration diagram</td>
<td>26</td>
</tr>
<tr>
<td>9.3</td>
<td>Collision and exclusion zones</td>
<td>26</td>
</tr>
<tr>
<td>9.4</td>
<td>Pinpointing configuration states</td>
<td>28</td>
</tr>
<tr>
<td>9.5</td>
<td>Exclusion zones and semaphores</td>
<td>29</td>
</tr>
<tr>
<td>9.6</td>
<td>Viewing critical sections and semaphore signs</td>
<td>30</td>
</tr>
<tr>
<td>9.7</td>
<td>Subdivision of exclusion zones</td>
<td>31</td>
</tr>
<tr>
<td>10.1</td>
<td>Net analysis</td>
<td>33</td>
</tr>
<tr>
<td>10.2</td>
<td>Performing net analysis</td>
<td>33</td>
</tr>
<tr>
<td>10.3</td>
<td>Generated semaphore signs</td>
<td>33</td>
</tr>
<tr>
<td>10.4</td>
<td>Deadlock cycles</td>
<td>33</td>
</tr>
<tr>
<td>10.1</td>
<td>Net analysis</td>
<td>33</td>
</tr>
<tr>
<td>10.2</td>
<td>Performing net analysis</td>
<td>33</td>
</tr>
<tr>
<td>10.3</td>
<td>Generated semaphore signs</td>
<td>33</td>
</tr>
<tr>
<td>10.4</td>
<td>Deadlock cycles</td>
<td>33</td>
</tr>
<tr>
<td>11.1</td>
<td>AGV-shape editor</td>
<td>35</td>
</tr>
<tr>
<td>12.1</td>
<td>Parameter options</td>
<td>36</td>
</tr>
<tr>
<td>12.2</td>
<td>Granularity</td>
<td>36</td>
</tr>
<tr>
<td>12.3</td>
<td>Grid spacing</td>
<td>36</td>
</tr>
<tr>
<td>12.4</td>
<td>Turn radius</td>
<td>36</td>
</tr>
<tr>
<td>13.1</td>
<td>Printing</td>
<td>38</td>
</tr>
<tr>
<td>13.2</td>
<td>Printing the road map layout</td>
<td>38</td>
</tr>
<tr>
<td>13.3</td>
<td>Printing a configuration diagram</td>
<td>38</td>
</tr>
<tr>
<td>13.4</td>
<td>Printing of a list box</td>
<td>38</td>
</tr>
<tr>
<td>14.1</td>
<td>Traffic simulation</td>
<td>39</td>
</tr>
</tbody>
</table>
1.1. Functionality

RoadPlan is a tool to analyze, visualize and optimize the traffic layout and traffic control of multi-AGV systems.

At present the following main features are available:

- *Road maps* can be created interactively or loaded from road map files. The road map layout is visualized graphically on the screen. It constitutes the ground plan for the traffic analysis and animation.
- The road map layout may be edited. The modified road map can be saved to a file in order to be reloaded at a later stage.
- Within the road map any number of routes may be defined. Route definitions are stored as part of the road map.
- A *net* of agv’s on given routes and with given shapes may be selected for collision analysis. The mutual collision states of all agv’s are determined.
- For any specific pair of agv’s the collision states may be shown within a configuration diagram.
- Each mutual state of two agv's – pinpointed in the configuration diagram - can be made visible in the road map layout.
- Based on the collision and deadlock analysis exclusion and deadlock avoidance zones are computed automatically.
- The semaphore signaling needed for collision and deadlock avoidance is generated automatically.
- Agv-shapes can be edited, the impact of which can be evaluated immediately.
- The control of any net of agv’s, based on semaphore signaling, may be simulated interactively.

Future developments are envisaged with respect to the following topics:

- Dynamic priority scheduling of agv’s
- Dynamic velocity synchronisation between agv's.
- Dynamic route adaptation

1.2. Using RoadPlan - overview

The RoadPlan program runs on Linux systems and makes use of the TCL/TK toolkit. More about the installation and structure of RoadPlan is found in [Using the RoadPlan Program](#) on page 6.

Before traffic layouts can be analyzed, layouts have to be created or loaded from road map files. Road map files are ordinary text files that specify traffic layouts consisting of tracks, routes along tracks, agv-shapes, etc. See [Creating a road map file](#) on page 9.
The typical procedure of using RoadPlan is as follows:

- Load a traffic layout from a road map file. See [Loading a road map file on page 14](#). A road map basically consists of a collection of tracks. All tracks of the road map are visualized graphically.

- Traffic layouts can be modified by means of adding or removing tracks. Additional tracks may be drawn in a road map interactively. This way, one may even create traffic layouts completely from scratch. See [Creating or modifying a road map interactively](#) on page 21.

- Modified road map can be saved in a road map file for later reuse. See [Saving the layout to a road map file](#) on page 23.

- Select a set of routes as current net or select a predefined net for collision analysis. See [Defining Routes](#) on page 19 or [Net analysis](#) on page 32.

- Evaluate the results of the analysis. For any selected pair of routes a mutual configuration diagram may be shown. See [Mutual analysis of agv’s](#) on page 26.

- Semaphores guarding the exclusion and avoidance zones are generated. Semaphore positioning and zone sections along the routes can be made visible.

At any stage of the analysis a number of different actions can be taken:

- Viewing of road map items, both textually and graphically. See [Viewing the road map layout](#) on page 16.

- Changing parameter settings that may influence the presentation and/or modify the analysis results. See [Parameter options](#) on page 36.

- Editing of the geometry of vehicle shapes. See [AGV-shape editor](#) on page 35.

- Printing of the drawing window area’s and printing of textual list boxes. See [Printing](#) on page 38.

- Animation of agv’s on the road map. See [Traffic simulation](#) on page 39.
2.1. Installing and running RoadPlan

The RoadPlan program package is shipped as a compressed tar-file. The version described in this manual is named \textit{rp3.1.tgz}.

The RoadPlan package will be expanded in a directory \textit{roadplan} by the following tar-command:

\begin{verbatim}
tar -xzf rp3.1.tgz roadplan
\end{verbatim}

When changing thereafter to the created directory \textit{roadplan}, the RoadPlan program is simply started by calling:

\begin{verbatim}
./roadplan
\end{verbatim}

The package requires the presence of appropriate \textit{tcl} and \textit{tk} libraries.

2.2. Software overview

The RoadPlan software is organized within three distinguished layers:

- \textit{RP-Script}: the graphical user interface based on the Tcl/Tk scripting language
- \textit{RP-Shell}: application specific interface layer written in C serving as extension of the Tcl-command shell
- \textit{RP-Core}: basic application functions in C-language
Using the RoadPlan Program

Figure 1  Global structure and functioning of RoadPlan

2.3. RP-Script layer

The Tcl-script files in this layer are found in the roadplan/tcl subdirectory and have extension .tcl. The main Tcl/Tk script is named roadplan.tcl. Calling the script `roadplan` actually calls for wish <roadplan.tcl. Wish is a simple windowing shell interpreting Tcl/Tk commands. By means of the first command line in the file roadplan.tcl, this call expands into a restart using the RoadPlan's shell rpshell. Rpshell is the executable file created by compiling and linking of the C-programs in the RP-Shell and RP-Core layers.

The main script roadplan.tcl defines the global setup of the graphical user interface. It creates the main window structure with menu options and a special draw area for the road map layout. It attaches the required callbacks of procedures to menu buttons, mouse clicks, etc. For reasons of manageability some parts of the complete script program are placed apart in separate files and "included" by the main script.

At the moment of writing the following scripting subfiles are used:

- netlayout.tcl, that shows and manipulates the road map layout;
- analysis.tcl, that visualizes the results of critical analysis for pairs of routes in a separate configuration window;
- simulation.tcl, that plots and animate agv's following routes in the road map layout.
- vehicledef.tcl that allows for editing of agv-shapes in a separate window.
2.4. RP-Shell interfacing

This RP-shell layer contains C-programs that provide an application specific interface for the RoadPlan Tcl-script. At start-up a number of roadplan procedures are registered as new Tcl-commands. The interaction between the Tcl-script and the interface layer may be traced by enabling the *Tcl Interface* debug mode in the pull-down menu *Debug*.
A road map file describes a particular traffic layout. The road map file contains definitions of layout components such as tracks and routes. Moreover it may define vehicle shapes and other variables specific for the traffic environment. The road map file format is designed to be parsed easily and to be readable/editable by humans. The road map-file consists of ASCII text and simple constructs to introduce layout and shape elements. The syntax enables structured composition of complex layout constructs in terms of more basic layout components. The hierarchy of layout elements used to specify the traffic layout is built-up by respectively poses, tracks, routes and nets as explained in the following sections.

3.1. Poses
The specification starts with the notion of a pose, being the position (x, y) and the orientation o of an object in 2-dimensional space. A pose is given by a 3-tuple (x, y, o) as expressed by the syntax rule:

\[ \langle \text{pose} \rangle ::= \langle \text{number} \rangle \ \langle \text{number} \rangle \ \langle \text{number} \rangle \]

A certain pose may be named explicitly by a pose definition as follows:

\[ \langle \text{pose-def} \rangle ::= \text{defpose} \ \langle \text{name} \rangle \ \langle \text{pose} \rangle \]

The orientation of a pose, which should be expressed in radians, may be left open by supplying a '*' character instead:

\[ \langle \text{pose} \rangle ::= \langle \text{number} \rangle \ \langle \text{number} \rangle \ * \]

In that case the pose is "unoriented". The orientation is defined implicitly by the track curve starting or ending in the given pose (see later). Poses are used in the definition of tracks and routes as explained below. They can be referenced either by a 3-tuple or by the name of a pose defined before, according to the syntax rule:

\[ \langle \text{pose-ref} \rangle ::= \langle \text{pose} \rangle \ | \ \langle \text{pose} \rangle \ \langle \text{name} \rangle \]

3.2. Tracks
A track is an interconnecting curve between two poses. Therefore, just supplying two poses specifies a track:

\[ \langle \text{track} \rangle ::= \langle \text{pose-ref} \rangle \ \langle \text{pose-ref} \rangle \]

A certain track may be named on its own and referenced, in the same way as with poses, by the syntax rules:

\[ \langle \text{track-def} \rangle ::= \text{deftrack} \ \langle \text{name} \rangle \ \langle \text{track} \rangle \]

\[ \langle \text{track-ref} \rangle ::= \text{track} \ \langle \text{name} \rangle \]

At present track curves are considered to be either straight line segments or circle segments (arcs). This means that curves have a constant curvature. Straight-line segments have zero curvature, circle arcs have curvature \( 1/\rho \) with \( \rho \) being the curve radius.

Suppose the differences between the start-pose and end-pose of a track are given by \( \Delta x \), \( \Delta y \) and \( \Delta o \). If \( \Delta o = 0 \) then the curvature = 0. Otherwise the curve radius is calculated by:
\[ \rho = \sqrt{\frac{N}{D}} \] with \( N = \Delta x^2 + \Delta y^2 \) and \( D = 2(1 - \cos(\Delta \theta)) \)

The orientations of the endpoints of a circle segment are dependent on each other. Therefore, if the orientations of both poses are specified they should match. If only one orientation is given, the other is implied. Hence always one of the poses may be left unoriented. However, the case where both endpoints of a track are unoriented leads to a straight curve.

### 3.3. Routes

A route is specified as a sequence of poses and/or tracks. Also compound routes may be constructed out of previously defined simpler routes. This leads to the following syntax rules:

\[
\text{<route-def>} ::= \text{defroute } \text{<name>} \text{<route-item>}
\]
\[
\text{<route-item>} ::= (\text{<pose-ref>} | \text{<track-ref>} | \text{<route-ref>})^* \text{endroute}
\]
\[
\text{<route-ref>} ::= \text{route } \text{<name>}
\]

In this specification a track just represents 2 subsequent poses, and a route an arbitrary sequence of poses.

The syntax as described allows to specify routes by simply enumerating all its intermediate poses (supplying lists of 3-tuples) or by stepwise composition using poses, tracks and routes defined before.

### 3.4. Nets

We finally define a net as a set of routes. The notion of a net is presently only used to restrict the collision analysis to a limited selection of routes. The notion could however be useful in the future for structuring further relationships between routes. For example one may specify sets of alternative routes or sets of interconnected routes.

The net definition is reflected in the following syntax rules:

\[
\text{<net-def>} ::= \text{defnet } \text{<name>} \text{<net-item>}
\]
\[
\text{<net-item>} ::= (\text{<route-ref>} | \text{<net-ref>})^* \text{endnet}
\]
\[
\text{<net-ref>} ::= \text{net } \text{<name>}
\]

### 3.5. Agv-types

Currently only simple agv-shapes can be defined according to the syntax:

\[
\text{<agv-def>} ::= \text{vehicle } \text{<name>} \ (\text{<basic-shape>} | \text{<combi-shape>}) \text{endvehicle}
\]
\[
\text{<basic-shape>} ::= \text{disc } \text{<diameter>} | \text{rect } \text{<length><width>}
\]
\[
\text{<combi-shape>} ::= (\text{basic-shape})^*
\]

This syntax allows specifying a circular or rectangular agv-type, or a combination of both. In the latter case, the resulting shape is meant to be the intersection of the basic shapes.

### 3.6. Environment variables

The road map file may contain declarations of variables as follows:

\[
\text{<variable-def>} ::= \text{set } \text{<name>} \text{<parameter_list>}
\]
\[
\text{<parameter_list>} ::= (<\text{parameter-item}>)^* \\
\text{<parameter_item>} ::= \text{<number> } | \text{<string>}
\]

In this way layout environment variables may be specified. This option is not yet used.
3.7. Example road map file

```plaintext
# Example road map file.
# Lines starting with '#' are comment in the road map file
# The newline character '\n' is used as delimiter

# Variables are declared as follows:
# set <varname> <parameter list>
#
# Variables can be simple or compound and contain either
# a single value or a list of values.

set mapname example
set granularity coarse
set turnradius 2.0

# Poses are defined as follows:
# defpose <name> <x_pos> <y_pos> <orient>
#
# where <name> ::= IDENTIFIER
# <x_pos> ::= FLOAT
# <y_pos> ::= FLOAT
# <orient> ::= FLOAT | '*'
#
# If the character * is given instead of a float number
# the orientation is defined implicitly by the track or route
# in which the pose appears.

defpose north 0.0 20.0 3.14159
defpose west -20.0 0.0 -1.5708
defpose south 0.0 -20.0 0.0
defpose east 20.0 0.0 1.5708

# Tracks are defined as follows:
# deftrack <name> <pose_spec> <pose_spec>
#
# where <pose_spec> ::= <x_pos> <y_pos> <orient>
# | [pose] <pose_name>
#
# one-sided specified orientations give straight tracks
deftrack north_in_tangent 40.0 20.0 * north
deftrack west_in_tangent -20.0 40.0 * west
deftrack south_in_tangent -40.0 -20.0 * south
deftrack east_in_tangent 20.0 -40.0 * east
deftrack north_out_tangent north -40.0 20.0 *
deftrack west_out_tangent west -20.0 -40.0 *
deftrack south_out_tangent south 40.0 -20.0 *
deftrack east_out_tangent east 20.0 40.0 *

# both-sided specified orientations give curved tracks
deftrack north_west_arc north west
deftrack west_south_arc west south
deftrack south_east_arc south east
deftrack east_north_arc east north
```
Creating a road map file

# Routes are defined as follows:
#  
#  defroute <name>
#  <pose_spec> | <track_spec> | route <name>
#  <pose_spec> | <track_spec> | route <name>
#  ...
#  <pose_spec> | <track_spec> | route <name>
#  endroute
#  
#  where <track_spec> ::= <pose_spec> <pose_spec> | track <name>

defroute east_to_south
track north_in_tangent
track north_west_arc
track west_out_tangent
endroute

defroute west_to_north
track south_in_tangent
track south_east_arc
track east_out_tangent
endroute

defroute north_to_west
track west_in_tangent
track west_south_arc
track south_east_arc
track east_north_arc
track north_out_tangent
endroute

defroute south_to_east
track east_in_tangent
track east_north_arc
track north_west_arc
track west_south_arc
track south_out_tangent
endroute

# Vehicles shapes are defined as follows:
#  
#  defvehicle <shapename>
#  [rect <length>, <width>]
#  [disc <diameter>]
#  endvehicle

defvehicle agv_rect
   rect 4.00 2.00
endvehicle

defvehicle agv_disc
   disc 3.00
endvehicle

defvehicle combi
   rect 4.00 2.00
   disc 3.00
endvehicle
Creating a road map file

```
# Nets are defined as follows:
# defnet <name>
#   <member_spec> | net <name>
#   <member_spec> | net <name>
#   ...
#   <member_spec> | net <name>
# endnet
#
# where <member_spec> ::= route <name> [vehicle <name>]
#
defnet ew_turn_90
  route east_to_south
  route west_to_north
endnet

defnet ns_turn_270
  route north_to_west vehicle combi
  route south_to_east vehicle combi
endnet

defnet all
  net ns_turn_270
  net we_turn_90
endnet
```

The resulting roadmap layout is visualized below.
A new road map is loaded by choosing the **Load**-option of the **File**-menu and selecting a road map file. The file search starts in the subdirectory **map**.

### 4.1. The loading process

The loading process will go through the following phases.

- **Parsing of the road map file.**
  The scanner/parser for the road map files has been generated by means of Lex/Yacc tools. In case of a parsing error a message will pop-up reporting the line number and the expected scanner symbol. Also wrong or unknown identifiers are reported.

- **Check for the semantic correctness.**
  The consistency of the track parameters is checked. The orientation at the endpoints should (if supplied) be in accordance with the orientation of the chord (straight line between the endpoints).

- **Replacement of the current traffic layout.**
  If the road map file is syntactically and semantically correct, then the previous layout is removed. The traffic layout of the newly loaded road map is shown instead. All traffic layout items are replaced, except for the default agv.
  The traffic layout - visualized in the main window - consists of all tracks defined by the road map. Tracks could have been defined explicitly by a track definition or implicitly by a route definition (see below).

- **Smoothing of routes (see below).**

### 4.2. Tracks in the layout

Tracks are created either explicitly by a track definition in the road map file (deftrack <name> …) or implicitly by the specification of subsequent poses in a route definition. Tracks can be straight line segments as well as circle segments. Tracks are created in all cases where subsequent poses in a route do not coincide. Poses listed in a route are generally distinct, but also tracks could not fit together and generally do not coincide with poses before and/or after. In the route definition shown additional tracks are generated if pose x ≠ pose y, if pose y ≠ the initial point of track x, if the final point of track x ≠ the initial point of track y, etc. Poses are considered to
coincide - irrespective of their orientation - if their positions are equal (within some tolerance).

In a route any pose (apart from the first and last) connects at least two tracks. If multiple routes pass through coinciding poses these points will connect more tracks. The orientation of a pose is only relevant for the geometry of the curves of the tracks meeting at the node. Meeting tracks may have different orientations. If a route passes along tracks that meet at different orientations an attempt is made to solve this discontinuity (see [Smoothing of routes](#)).

One additional rule is introduced to handle track-wise specification of a route. If subsequent poses of a route are equal, then these poses merge to a single pose. This allows for specification of a route by subsequent tracks such that the end-point of a previous track coincides with the begin-point of the next track.

### 4.3. Smoothing of routes

If the orientation of connected tracks on a route is not continuous, we have an unrealistic situation. In such cases agv's will make an instantaneous orientation jump when switching tracks. As a result the collision analysis will not conform to the real physical world.

Inserting extra curves solves such discontinuities. The radius of these extra smoothing curves is a fixed parameter turn radius that can be set by the options-menu. The extra curves are made visible in the layout by stippled curves. Smoothing of some orientation discontinuities in a route could fail if the connection angle is too sharp (relative to the segment lengths). A message will appear to mention routes that could not be smoothed completely.
5.1. Adjusting the viewing region

The road map layout can be scaled and/or scrolled in order to zoom-in at a specific area of the road map. A scale widget and "magnification glass" buttons are situated in the right lower part of the main window (see Figure 2). To zoom into a specific region the button with the + in the magnification glass icon may be pressed after which a square region of the layout may be grabbed with the mouse (press left button and move). The other magnification glass buttons will (re)adjust the road map to fit within the window.

![Figure 2](image)

5.2. Coordinate positions

The current location of the mouse cursor within the layout can be read at the bottom side of the road map drawing area. The x-coordinate runs horizontally and increases to the right. The y-coordinate runs vertically and increases in upward direction. The coordinates of the road map layout reflect the coordinates of the tracks as specified in the road map file.

5.3. Track and route identification

When the cursor points near or above a track, the indicated track is shown in red color and the corresponding track label and the labels of all routes passing the track appear in the bottom frame. These labels contain numbers, not the track and route names of the road map file. The correspondence of names and numbers can be found by viewing the track and route road map items (select Items in the pull down menu View).
5.4. Viewing road map text items

All items as specified by the road map file, such as variable, poses, tracks, routes, nets and vehicles can be inspected by choosing Items in the pull down menu View. The text of the road map file is shown in a separate window when selected by the entry Configuration text in the pull down menu View.

5.5. Viewing routes

In order to view a specific route in the road map layout move in the View menu to the submenu Route and point at or select some Route_<n>. The route will be highlighted in the road map (in yellow color). The highlighting of a selected route is cancelled automatically by any subsequent mouse click in the layout area.
In order to view routes that pass along a specific track one has to proceed as follows. Bring the mouse above the track and press the right mouse button. A selection pops up of the all routes that pass over the track. When thereafter - while pressing the mouse button - the mouse is moved over the route items the indicated route is highlighted in the layout (in yellow color). This procedure is part of the route selection process (see Chapter 6). If the right mouse button is released, while indicating some route, this route is selected and will become blue. The selection can be undone by pressing the middle mouse button (if not available, press the left and right mouse button together at the same time) somewhere in the layout area, or by clicking on the route-CLR button (see Figure 3).

5.6. Viewing of agv-types scaled in the road map

To view the different agv-type models on scale in the road map layout move in the View menu to the submenu Agv shape and pass over the Model_<n> entries. The shape of the agv-type models will be shown in the center of the road map in yellow color.
6.1. Selecting existing routes

Existing routes – either specified initially by the road map file or defined later - may be selected by bringing the mouse above one of its tracks. By pressing the right mouse button while the mouse pointer is positioned on a track, a selection pops up of the all routes that pass over the track. When thereafter - while keeping the mouse button pressed - the mouse is moved above a route entry of the pop-up menu and the mouse button is released again, the route concerned is selected. During this procedure the currently selectable route is highlighted in the layout (in yellow color). In this way one does see which route will be selected if one releases the button. A selected route appears in blue color. An existing route may be selected and extended to define a new route as explained below.

6.2. Defining new routes

New routes are defined by selecting tracks or by extending existing routes. Even new tracks may be created during route selection if the Add Tracks mode is enabled. This mode allows the road map layout to be modified. Interactive road map building and editing is described in a following chapter. For the moment, we consider route construction by selection of existing tracks.

The construction of a new route may start by selecting a single track or route, either by pressing the left-mouse button while the mouse pointer is on top of a track (a currently focused track is showing red) or by pressing the right mouse-button and choosing a track or route in the pop-up menu. After a first track or route is chosen to build up a new route, connected tracks may be added to extend the route. The tracks of a new route, selected so far, appear in blue color. A new route may be extended with tracks before and track after the current route selection. All selectable tracks, i.e. tracks that connect to the beginning or the end of the current selection, appear in yellow color. Any of these tracks is selectable as extension of the current route.

Connected, selectable tracks will be added to the new route by clicking above them with the left mouse button. To select a track it always has to be in focus, that means the mouse pointer must be brought above the track such that the track turns to red. If a track (or route) is selected that does not connect to the newly build route, the selection is ignored.

Instead of extending a route by track selection, the chain of tracks may also be shrunken by removing (repeatedly) one of the outer tracks. If the first or last track of the blue colored route is clicked upon, the track will be deselected.

In order to remove the whole selection one could click on the route-CLR button (see Figure 3) or press the middle-mouse button in the road map. (Note that if layout...
Defining Routes

ing editing is allowed, pressing the middle-mouse button just above a track will delete this track.)

In order to define the current track selection as new route one must click on the Route-DEF button in the main menu bar (see Figure 3). The route defined remains visible in blue color as if currently selected.

![Figure 3 Buttons in the main menu bar for defining or clearing of currently made or modified routes and nets.](image)

Also initial or final parts of existing routes may be added to a newly build route. If the mouse cursor is on top of a track that extends the current selection and a route passing this track is selected by using the pop-up menu (right-button press), then this route will be added as extension. More precisely, either the initial part of the route is taken that extends before the newly build route or the final part of the route is taken that extends after the newly build route.

The pop-up menu can contain routes that do or do not connect to the track sequence selected so far. Routes that extend the tracks selected appear in yellow colored menu entries. Choosing a yellow entry leads to prolongation of the route, choosing a blank entry will be neglected.
Chapter 7  Creating or modifying a road map interactively

7.1. Enabling editing of the track layout

The layout of all tracks constitutes the basic ground plan of the road map. The track layout remains fixed unless the layout editing mode is explicitly enabled by pressing the Add Tracks button. The interactive editing mode is enabled at startup while the road map is empty. After loading of a road map file the editing mode will be disabled. It should be enabled explicitly if one wants to modify the track layout.

7.2. Starting from scratch

After the startup of RoadPlan, one may decide to create a new road map from scratch without loading an existing road map file. Also at any later stage one could make a restart with a clean drawing area (possibly after saving the current road map) by choosing the Clear-option of the File-menu. Before drawing tracks of a road map one should be aware of the scaling and precision desired. The proper dimension of the drawing area can be adjusted by means of the scale widget (see Adjusting the viewing region on page 16). The actual drawing may be supported by using grid lines. These are made (in)visible by the grid button in the right lower part of the main window. The resolution of selectable grid points depends on the actual grid spacing value. The grid spacing is one of the parameter options in the Options pull-down menu (see Chapter 12). Grid lines will – when increasing the magnification – eventually be spaced exactly according to the resolution chosen.

7.3. Extension of a route beyond the existing track layout

New tracks are added to the road map when a new route is defined along not yet existing tracks. During creation or extension of a route the user may decide to follow existing tracks or routes and may choose to pass along tracks not yet present.

The formation of a route along new tracks may start at some initial point or at any stage of route building as described in Defining new routes on page 19. In order to start or continue a route along non-existing tracks one has to place a route extension point in the road map. A route extension point will appear only if the layout editing mode is enabled.

The route extension point can be evoked at the beginning or ending of the currently selected track sequence (shown in blue) by pushing the forward extension or the backward extension button (see Figure 4). A route extension marker will appear as a small blue circle at the beginning or end of the route. If the route extends at the end, news track will be added in forward direction after the last track. If it extends at the beginning, new tracks are added in backward direction before the first track.
If one starts from scratch while no track sequence is selected yet, an initial route extension point may be placed anywhere in the road map. By clicking with the left mouse button at some position in the road map, the blue extension marker (small blue circle) will appear. The extension direction is forward by default, but can be chosen at will by pushing the extension buttons.

Positions in the road map taken as initial route extension point can be of two types:

1. existing connection points (i.e. track termination and/or junction points)
2. new map points not used before in the layout

Track termination points show up by a red circle as the mouse is pointing at them. When the red marker appears the point is in focus as potential connection point and may be selected by pressing the left mouse button. The red marker will change into a blue extension marker.

By clicking with the left mouse button outside the existing layout a new connection point is placed. The position may be constrained to grid positions (see grid spacing).

Figure 4   Buttons in main menu bar related to extension of routes along new tracks

Figure 5   A new route (in blue) is made by adding a curved track that joins again to an existing track (shown in yellow because it is selectable as forward extension).
7.4. Creation of tracks during route continuation

Once the route extension marker is placed, it will serve as the starting or the destination point of a track to be made. Two modes of track creation are distinguished:

1. **straight line interconnection** between the extension point and the mouse position while clicking the left mouse button. The “click point” may be an existing connection point being in focus or a new map position (constrained to the selected grid).

2. **curved line interconnection** obtained by dragging the mouse - with the left mouse button pressed - from the extension point to another position. The curve will be a circle segment that matches the orientation of the current route. The destination point of the curve may be an existing connection point that comes into focus or a new map position (constrained to the selected grid). The point will be selected when releasing the mouse button. In case of a single (initial) connection point or a very small orientation difference the curve will degenerate to a straight line.

New tracks made will extend the currently build route and are colored blue. Extension of the route may occur at either side of the route by switching the extension direction.

The outer tracks of the current route selection may be withdrawn again from the selection in the following ways:

1. Withdrawal of the most recently added tracks by using the “undo button” (see Figure 4). In this case the track does not remain in the layout.

2. Clicking on an outer track of the blue track sequence will remove this track from the selection as described in 6.2. A newly made track will remain in the layout.

7.5. Deletion of tracks and/or routes

If layout editing is enabled a track could also be removed, provided no routes are passing along the track. A track “in focus” (i.e. turning into red by pointing at it) will be deleted by pressing the middle mouse button. If a track cannot be removed because the track is part of some routes, an information box will appear telling the routes that are passing.

In order to free tracks from being used, one can remove routes by opening the submenu **Delete route** of the **Edit** menu and selecting the route.

7.6. Saving the layout to a road map file

A created or modified layout may be save to a road map file. All existing tracks and routes are written in the file according to the layout syntax as described in Chapter 3. The automatically generated road map file does not conserve all the information present in user-constructed road map files. For example **pose definitions** will not appear in saved road map files, as they are only useful to ease manual road map construction. For each track a separate definition with its coordinates is given. Presently, also user-defined route and net names have no function and are not conserved.
All modifications with respect to nets and vehicles, as described later, are saved in the road map file too.

The road map is saved by choosing the *Save*-option of the *File*-menu and selecting a road map file name. Existing files may be overwritten with explicit permission. The file search starts in the subdirectory *map*. 
Chapter 8  Net composition

8.1. A net as fleet of agv’s

In its most simple form, a net consists of a collection of routes. On each route a single agv is assumed to travel from the beginning to the end of the route. Often, all agv’s are equally shaped according to some common agv-type. Each agv is, however, considered as being a distinct member of a net with its own route and shape. Any agv-type may be selected on any route. As a consequence, more than one agv may be placed on a single route.

8.2. Selection of agv’s on routes

Individual agv’s are placed on routes (and added to the current net) by choosing the submenu Agv on route of the Select menu. This option creates a cascade of submenu’s. By moving the cursor, first some Route_<n> is selected, second some of the available agv-types Agv_<n> is selected. During the cursor movement, indicated routes and agv-types are highlighted in the road map layout. Agv’s are visualized at the beginning of their routes. After selection, the agv placed together with its route are visible by their individual coloring.

Selected agv’s are added as members to the current net. In this way, any fleet of agv’s can be composed as a net in order to be analyzed and simulated later. An existing net, after being selected as current net, may be extended by selecting additional agv’s. The current net is saved as predefined net (and may be selected later again) by clicking on the net-DEF button in the main menu bar (see [Figure 4] on page 22).

The current selection is cleared by clicking on the net-CLR button. Presently, net members can not be removed individually.

8.3. Selection of an existing net

Nets may have been predefined in the road map file or may have been defined later by the user. An existing net is selected by choosing the submenu Agv’s of Net of the Select menu. By moving the mouse cursor over the Net_<n> entries, while keeping the left mouse button pressed, the indicated net is displayed and may be considered for selection. By selection of an existing net, previously selected agv’s are removed. The existing net now becomes the current net.

8.4. Operations on the current or any existing net

The current or any predefined net constitutes the basis for traffic analysis and simulation. We mention the following actions that can be performed:

- Simultaneous analysis and zone generation of all agv’s in a net. See [Net analysis] on page 33.
- Simulation of the current or a predefined net. See [Traffic simulation] on page 39.
Chapter 9  Mutual analysis of agv's

The analysis phase needed to generate traffic signaling and perform traffic simulation, could remain hidden for the user. After a net of agv’s is defined, the user may immediately step over to the simulation phase. However, it may be useful to inspect collision states. Also, one may like to observe, or even influence the way collisions are avoided by exclusion zones. For a large part, the analysis of a net breaks down into the pair-wise state comparison of all agv’s. This chapter provides the basic background to understand the determination of mutual collision states and the generation of exclusion zones. RoadPlan enables detailed inspection of the mutual configuration states of any pair of two agv’s. Going through these details will be helpful to oversee the effects when a complete net is analyzed, as described in the next chapter.

9.1. Mutual analysis selection

Any pair of agv’s in the current net may be selected for mutual comparison, irrespective the current working stage of RoadPlan. The main menu item Analysis contains the option Select Pair that creates a two-level cascade of Agv_<n> entries. The colors of the entries correspond to the coloring of the selected agv’s in de road map layout. By moving the mouse cursor, with the left mouse button pressed, any combination of two agv’s can be chosen. The combination indicated will be selected when releasing the mouse button. The mutual analysis of any selected pair of agv’s is presented in a separate window, named the Mutual Configuration Diagram. If not yet present, the window will be created, otherwise it will pop up.

9.2. Mutual configuration diagram

The mutual configuration diagram shows the result of the comparison of two selected agv’s on their routes. The position of the first agv is shown horizontally, the position of the second agv is shown vertically. We distinguish both agv’s by referring respectively to agv-X on route-X, being the first agv, and to agv-Y on route-Y, being the second. All possible configuration states of both agv's are presented as a 2-dimensional diagram. The route coordinates, with values from 0 up to the length of each route, are projected along the horizontal and vertical axes of the diagram.

9.3. Collision and exclusion zones

Collision analysis of two agv's - each on their route - is broken down into the computation of collision states for each combination of route segments. Collision states are expressed in terms of these route coordinates. They are visualized within the mutual configuration diagram of two routes, as shown below.
Any rectangular area in this configuration diagram is called a *cartesian zone* as it is the cartesian product area of sections on both routes.

Collision states are drawn as white areas in the configuration diagram window. White areas actually cover collision states with some accuracy. Collision states are represented by a collection of small disjoint subzones collected during the analysis process. The granularity can be chosen as *coarse, medium* or *fine* (click *Granularity* in the *Options* menu).

Collision states are encapsulated by rectangular *exclusion zones*, shown by blue boxes. These zones enclose (in a minimal way) a connected area of collision states. The exclusion zones together cover all collision states.

Rectangular exclusion zones also eliminate mutual deadlock states between the two agv's. If agv's for example drive in opposite directions over a common road section, the collision pattern is shaped as shown in the Figure 6. Forwards moving agv's could enter an area with deadlock states as indicated before finally meeting a collision state.
Mutual analysis of agv’s

The exclusion zone also covers deadlock states, i.e. states that (in case of forward moving agv's) will inevitable lead to a collision state.

9.4. Pinpointing configuration states

Each point in the mutual configuration diagram represents a configuration state of the agv's.
By pressing the left-mouse button in the configuration diagram the actual "physical state" of the agv's that corresponds to the pointed configuration state is made visible in the road map layout as shown in Figure 7. The agv's with their real shapes and positions will appear in the road map area of the main window.

“Current state” lines – colored according to the agv’s - are drawn horizontal and vertical in the configuration diagram to accentuate the actual coordinate positions along the routes. The actual route coordinates are shown in the bottom frame below the diagram.
By moving the mouse while keeping the left-button down one may follow the agv's as they move along their routes in correspondence with the configuration state.
Mutual analysis of agv’s

Figure 7  Mutual configuration diagram: the agv’s are shown in the road map according to the "pinpointed" configuration state.

It is very illustrative to look for collision states or states inside and outside exclusion zones in the configuration diagram and to see the corresponding agv-constellation. It may be observed that the white collision area is sometimes taken rather "safe". In particular for non-straight route segments safe approximation bounds may work out quite conservative. However, the granularity of the approximation may be adjusted in the Options menu (click Granularity).

One may wish to relate configuration states to specific tracks on the routes. The track boundaries could be drawn in the mutual configuration diagram. Choose the item Show Track Boundaries in the View pull-down menu.

9.5. Exclusion zones and semaphores

The exclusion zones shown as blue boxes in the configuration diagram determine the semaphores needed to implement collision avoidance.

The projection of a cartesian exclusion zone on each of the routes defines two related critical sections for which mutual exclusion must hold. Each exclusion zone gets its own semaphore. At the beginning of each of the related critical sections a claim on the semaphore is required. At the end of each of the related critical sections the claimed semaphore must be freed again. In other words, the critical sections of an exclusion zone are enclosed by claim- and free-operations on a common semaphore.

The claim- and free-operations on semaphores could be considered as specific traffic signs placed along a route. The positions of these semaphore signs are automatically registered after the collision analysis is completed.
9.6. Viewing critical sections and semaphore signs

The positioning of semaphore signs for the compared routes can be made visible in the road map layout after the collision analysis is performed. By choosing the *Show signs X/Y*-option of the *View*-menu the traffic signs will appear in the road map as colored flags placed along the routes considered. Yellow flags represent *claim-signs*, green flags represent *free-signs*. By placing the mouse pointer above such a traffic sign, the label of the traffic sign will appear in the bottom frame. This label identifies the associated zone section. The label *claim.z.i* or *free.z.i* refers to a unique zone number “z” and the index “i” of the route section at hand.

When pressing the left mouse button above any traffic sign, the critical route sections of the associated zone will light up. Exclusion zones are always composed of two route sections (the corresponding flag labels have section indices 0 and 1). However, zones can be composed of more than 2 sections (see deadlock avoidance zones).

![Road map layout with semaphore traffic signs. The mouse cursor points to the free-sign free.1.1. The corresponding critical section "lights up", while pressing the left mouse button.](image-url)
Mutual analysis of agv’s

Also a textual list of claim- and free-signs along a route can be obtained. An ordered list for route-X or route-Y is presented in a list box by selecting the item List Signs Route X or List Signs Route Y in the View menu. The textual traffic sign list is augmented with route points of track boundaries. The track boundaries are denoted as track I,j with i being the number of the track before and j the number of the track after the boundary (see the sign list in the figure). In this way the position of traffic signs could easily be related to the track the sign belongs to.

The contents of any list box can be printed to a file.

9.7. Subdivision of exclusion zones

The exclusion zones derived by mutual route comparison will - besides collision states - in general also cover many non-collision states. The determination of exclusion zones is by no way unique. The only prerequisite is that any collision state must be covered by (at least) one exclusion zone.

The exclusion zones as generated in RoadPlan fulfil the following requirements:

- Any continuously connected area of collision states is fully enclosed by a single cartesian zone.
- Exclusion zones are non-overlapping.

This choice will lead in general to large blocks of exclusion of which only a small fraction corresponds to collision areas. A more optimal coverage of collision states can be obtained by allowing overlapping exclusion zones. However, the choice of such zones is highly arbitrarily. Therefore it is not done automatically, but provided as manual facility with automatic support.

In order to split or join exclusion zones one has to drag the left-lower corner or the right-upper corner of an exclusion zone (blue box) with the mouse while pressing the right mouse-button. Dragging a corner inside the zone will make the zone smaller, dragging outside will make the zone larger.
An additional exclusion zone will be added automatically if needed to keep the collision area covered. In other cases existing exclusion zones are adapted automatically, or even removed if they are completely absorbed.

Currently the initially generated exclusion zones can only be subdivided into multiple overlapping zones (see Figure 8). The initial exclusion zones can not yet be made larger and merged together.

Note that subsequent overlapping exclusion zones along two routes implement a moving exclusion-block scheme. The way exclusion zones are split is based on the assumption that the agv's move forwards. Mutual deadlock is always eliminated. Agv's never have to backtrack.

Figure 8  Overlapping excluding zones (manually created)
Chapter 10  Net analysis

10.1. Performing net analysis

The net analysis for a specific net is invoked by going to the menu Analysis and selecting either the Current net or by opening the menu-item Net any net entry Net_<n> that has been defined beforehand.

The analysis of a net consists of two phases:
1. All agv’s of the net are compared for mutual collisions in a pair wise manner.
2. The resulting exclusion zones of step 1 are analyzed for possible deadlock.

The mutual analysis of agv’s in step 1 will be performed as far as needed. The results of any pair of agv’s already compared, as described in the chapter on Mutual analysis of agv’s, are reused. This is in particular important if the exclusion zones have been modified manually (see section 9.7 on Subdivision of exclusion zones).

10.2. Generated semaphore signs

After the analysis the generated semaphore signs (if any) will appear in the road map immediately. Yellow flags represent claim-signs, green flags represent free-signs. By placing the mouse pointer above such a traffic sign, the label of the traffic sign will appear in the bottom frame. This label identifies the associated zone section. We refer to section 9.6 Viewing critical sections and semaphore signs for more details. When pressing the left mouse button above any traffic sign, the critical route sections of the associated zone will light up.

A textual list of claim- and free-signs along a route is obtained by selecting the pull-down menu Signlist of the main View menu and choosing the wanted Agv_<n> entry. A list box pops up (if it does not already exists) containing a list of traffic signs ordered by the route coordinate. The textual traffic sign list is augmented with the route points of track boundaries. The track number before and the track number after the track switch are mentioned. In this way the position of traffic signs could easily be related to the track the sign belongs to.

The contents of any list box can be printed to a file.

Traffic sign flags shown in the road map are hided or made visible again by pressing the special “traffic sign button” in the bottom bar of the main window (see Figure 2 on page16).

10.3. Deadlock cycles

Immediately after the mutual collision analysis of a net, a search is made for cyclic dependencies between the generated exclusion zones. If deadlock cycles are found, deadlock avoidance zones are generated. Red flags will appear in the road map area representing the claim-signs of these avoidance zones. When pressing the left mouse button on this traffic sign, one will see that more than 2 critical route sections of the associated zone will light up. The number of sections corresponds to the number of agv’s involved in the deadlock cycle.
The deadlock cycle configurations can be viewed by going to the menu-item **Deadlock** in the pull down menu **View**. If deadlock situations exist, each of the entries **Cycle_<n>** will show, after selection, a different deadlock configuration on the road map.
The shape of a specific agv-type may be edited by choosing the entry \textit{Model\_<n>} via the \textit{Agv shape} option of the pull down menu \textit{Edit}. A separate window will appear if it is not yet present. The actual shape of the selected agv-type is shown. If no agv-types are defined in the currently loaded road map file, a default agv\_type \textit{Model\_<0>} is defined automatically.

The selected agv\_type may be changed by:
- Choosing a different basic shape using the pull-down menu \textit{Shape}. Available shape types are \textit{disc}, \textit{rect} and \textit{combi}. The combi-type refers to the intersection of a rectangular and circular shape.
- Adapting the length, width and/or diameter values by dragging the rectangle and/or circle that constitutes the boundary of the agv-shape with the mouse. By pressing the left-mouse button one can pick sides of the rectangle or a point on the circle. The actual values are shown also textually.

The modified agv-type is effectuated by pressing the button \textit{OK}.

![AGV Shape Editor](image)

Figure 3. The AGV-shape editor window. The shape of a \textit{combi}-type is formed by the intersection of a disc and a rectangle.
Some global parameters can be modified interactively. These parameters are selectable in the *Options* pull-down menu.

### 12.1. Granularity

The granularity parameter influences the accuracy of the collision analysis. The granularity parameter may be set to *coarse, medium* or *fine*. This setting will influence the "grain size" of the cartesian subzones for which the presence of collision states is computed. The collision analysis is based on a binary division strategy (quad tree method). Subzones with mixed collision and non-collision states are subdivided until they fall below some grain size. Subzones below this grain size that have still mixed states finally are treated as collision areas. In this way one obtains a safe approximation of the collision states.

When the granularity parameter is changed the configuration diagram (if present) is cleared. In order to obtain the configuration diagram with the changed granularity one has to invoke the analysis again by choosing the item *Selected Routes* in the pull-down menu *Analysis*.

### 12.2. Grid spacing

The option is relevant when creating or modifying the track layout interactively (Chapter 7). New track termination points are positioned in the road map according to the resolution specified by the current grid spacing. If the grid spacing value is for example 0.05 the x- and y-coordinates are rounded to multiples of 0.05. Grid adjustment may be avoided by taking the grid spacing value “none”.

The effect of grid adjustment becomes significant in case of large grid spacing values and/or in case of large magnification of the road map. If grid lines are made visible, using the grid button, these lines will conform to the actual grid spacing. The grid lines shown represent a resolution that never exceeds the grid spacing. By choosing a high magnification the lines will be spaced exactly by the actual grid value. In case of low magnification the grid lines will be spaced with a lower resolution.

### 12.3. Turn radius

The turn radius parameter influences the actual geometry of routes, if these routes contain repairable discontinuities in the orientation at track boundaries. See *Smoothing of routes* on page 15.

The turn radius can be set by means of a scale widget that appears when this parameter is selected for modification. The turn radius $\rho$ defines the curvature of the *smoothing curves* to be $1/\rho$. A small turn radius will induce a short and sharp turn. A
large turn radius gives a longer, less sharp turn. However, for a longer turn the connected tracks have to be longer too. If this is not the case the smoothing will fail.

The modification of the turn radius comes into effect when routes are smoothed subsequently. To change the current traffic layout one must reload the current road map file. The routes defined in the road map file will be smoothed again according to the modified turn radius.


<table>
<thead>
<tr>
<th>Chapter 13</th>
<th>Printing</th>
</tr>
</thead>
</table>

13.1. **Printing the road map layout**

The road map layout will be printed in Encapsulated Postscript form by choosing the *Print*-option of the *File*-menu. A *file browse window* will pop-up to select the print file. Default extension is .eps and default destination is the subdirectory *map*.

13.2. **Printing a configuration diagram**

The configuration diagram will be printed in Encapsulated Postscript form by choosing the *Print*-option of the *File*-menu in the Mutual Configuration Diagram. A *file browse window* will pop-up to select the print file. Default extension is .eps and default destination is the subdirectory *map*.

13.3. **Printing of a list box**

The contents of a list box will be printed as text file by pressing the *print*-button. A *file browse window* will pop-up to select the output file. Default extension is .txt and default destination is the subdirectory *map*.
RoadPlan offers some facilities for traffic simulation. It can display the simultaneous motion of agv’s according to dynamic control rules.

The animation of the current or any existing predefined net is invoked by selecting the appropriate entry of the *Simulation* menu. A separate *Net Simulation* window will appear for interactive control (see Figure 9). This window contains a slider for each agv of the net. This slider is coupled to the position of the agv along its route. By shifting the slider knob with the mouse (to the right) the agv will drive along its route on the road map.

The motion of agv’s is constrained by the traffic control rules, being:

1. Agv’s can drive only in forward direction.
2. Avoidance zones are claimed and released when passing traffic signs along the route.
3. Zones will block an agv at the claim point if the occupation is not allowed.

![Animation of agv's on the "testset" road map](image-url)
Automatic simulation can be started by pressing the *Run* button of the net simulation window. The agv’s will thereafter move simultaneously at some given speed. During simulation speeds may be controlled. By pressing the *Speed* button, a *Speed Control* window appears with sliders to adapt speeds of the agv’s individually. The + and – buttons will increase or decrease the speeds of all agv’s together.

The simulation can be stopped at any point using the *Stop* button. Before a simulation run and after a simulation stop, agv’s may be moves manually using the position sliders. However, during a simulation run the position sliders should not be shifted manually. This leads to unpredictable interference.

Any agv state can be taken as starting point of the simulation by shifting the sliders to the desired position. As backward driving is prohibited, it may be necessary to first reset agv’s to the beginning of their routes, before some joint state can be reached. Pressing the *Reset* button will bring the agv’s back in their initial state and free all zone occupations.
Index

Agv-type
  road map definition.......................... 10
  shape editing.................................. 36
Cartesian product................................. 28
Claim-sign........................................ 31
Collision
  avoidance ........................................ 30
  zones ............................................. 27
Critical section................................ 30
Curve
  smoothing ......................................... 15, 37
Deadlock........................................... 33
  avoidance zones .................................. 34
  cycle search ...................................... 34
  mutual ............................................. 28
Debug
  tcl interface ..................................... 8
  Exclusion zones .................................. 27, 30
  split or join ...................................... 32
  Free-sign .......................................... 31
  Granularity ....................................... 28, 30
  parameter .......................................... 37
Grid lines
  spacing parameter ................................ 37
  usage ............................................... 21
Magnification
  road map scaling buttons ...................... 16
Mutual analysis
  configuration diagram.......................... 27
  configuration state............................... 29
  select pair ........................................ 27
  show traffic signs ................................ 31
  subdivision of exclusion zones ............... 32
Mutual configuration diagram
  printing .......................................... 39
Net
  add agv’s.......................................... 25
  agy members ....................................... 25
  clear agy selection .............................. 25
  define a new agy selection .................... 25
  road map definition ............................. 10
  select existing net ................................ 25
  traffic simulation ................................ 40
Net analysis........................................ 34
  deadlock cycles .................................. 34
  generated traffic signs ......................... 34
Orientation
  discontinuity ..................................... 15
Pose
  coincidence ....................................... 15
  road map definition ................................ 9
Road map
  adjust viewing region ............................ 16
  coordinates ........................................ 16
  printing ............................................ 39
  scaling buttons ..................................... 16
  view items .......................................... 16
Road map file
  creation ........................................... 9
  example ............................................. 11
  loading ............................................. 14
  parsing of ......................................... 14
  saving .............................................. 23
  viewing text items ................................ 17
RoadPlan
  Installing ......................................... 6
  Software overview ................................ 6
Route
  clear selection ................................... 18, 19
  defining a new ..................................... 20
  delete ............................................... 23
  extension .......................................... 19, 20
  extension marker ................................. 21
  extension point .................................... 21
  identification ..................................... 16
  passing along track ................................ 18
  road map definition .............................. 10
  selection .......................................... 19
  shortening ......................................... 19
  smoothing .......................................... 15
  view in road map .................................. 17
Semaphore sign .................................... 30
  textual list ......................................... 32
Simulation
  run, stop, reset .................................... 41
  speed control ...................................... 41
Tcl
  interface ........................................... 8
  script files ......................................... 7
Track
  adding new ......................................... 21
  automatic creation of ............................. 14
  boundaries ......................................... 32
  delete ............................................... 23
  drawing new lines/curves ......................... 23
  identification ...................................... 16
  parameter consistency ............................. 14
  road map definition ................................ 9
  withdraw added tracks ............................. 23
Track layout
  editing ............................................... 21
  from scratch ....................................... 21
Turn radius
  parameter .......................................... 37
  smoothing curve .................................... 15
Variable
  road map definition .............................. 10
View
  agv-types scaled in the road map ............... 18
  deadlock cycles ..................................... 35
  road map text items ................................ 17
  route sign list ..................................... 32
  routes in road map ................................ 17